
Chapter 6

Editing Sketched Objects-II

After completing this chapter, you will be able to:
• Understand the concept of grips and adjust grip settings.
• Stretch, move, rotate, scale, and mirror objects with grips.
• Use the MATCHPROP command to match the properties of the selected object.
• Use the PROPERTIES palette for editing objects.
• Use the QSELECT command to select objects.
• Manage contents using the DESIGNCENTER.
• Use the Inquiry commands.

Learning Objectives
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Figure 6-2  Grip location of various objects

EDITING WITH GRIPS
Grips provide a convenient and quick means
of editing objects. With grips you can stretch,
move, rotate, scale, and mirror objects, change
properties, and load the Web browser. Grips
are small squares that are displayed on an
object at its definition points when it is
selected. The number of grips depends on the
selected object. For example, a line has three
grip points, a polyline segment has two, and
an arc has three triangular grips along with
the small square grips. These triangular grips
resemble arrowheads. These arrowheads
points towards the direction, in which the arc
can be edited dynamically.  Similarly, a circle has five grip points and a dimension (vertical) has
five. When you select the Enable grips and the Noun/verb selection check boxes in the Selection
tab of the Options dialog box, a small square (aperture box) at the intersection of the crosshairs
is displayed (Figure 6-1). The grip location of some of the objects is shown in Figure 6-2.

TYPES OF GRIPS
Grips can be classified into three types: unselected grips, hover grips, and selected grips. Selected
grips are also called hot grips. When you select an object, the grips are displayed at the definition
points of the object, which is highlighted as a dashed line. These grips are called unselected
grips (blue). Now, if you move the cursor over the unselected grip, and pause for a second, the
grid is displayed in green. These grips are called hover grips. Dimensions corresponding to a
hover grip are displayed when you place the cursor on the gip, as shown in Figure 6-3.  Next, if

Figure 6-1  Aperture box at the intersection of
crosshairs
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you select a grip on this object, it becomes a hot grip (filled red square). Once the grip is hot, the
object can be edited. To cancel the grip, press ESC. If you press ESC once, the hot grip changes
to an unselected grip. You can also snap to the unselected grip.

ADJUSTING GRIP SETTINGS

The grip settings can be adjusted using the options under
the Selection tab of the Options dialog box. This dialog
box can also be invoked by choosing Options from the
shortcut menu, see Figure 6-4. The shortcut menu is
displayed upon right-clicking in the drawing area.

The options in the Selection tab of the Options dialog box
(Figure 6-5) are discussed next.

Grip Size Area
The Grip Size area of the Selection tab of the Options
dialog box consists of a slider bar and a rectangular box
that displays the size of the grip. To adjust the size, move
the slider box left or right. The size can also be adjusted by
using the GRIPSIZE system variable. The GRIPSIZE
variable is defined in pixels, and its value can range from 1
to 255 pixels.

Menu: Tools > Options
Command: OPTIONS

Figure 6-3  Hover grip dimensions being displayed

Figure 6-4  Invoking the Options
dialog box from the shortcut menu



6-4                                                                                              AutoCAD LT 2006 for Designers
©

 C
A

D
C

IM
 T

ec
hn

ol
og

ie
s,

 U
S

A
. F

or
 o

nl
in

e 
tr

ai
ni

ng
, c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

Grips Area
The Grips area is used to control the display and the color of the grips.

Unselected grip color
This drop-down list is used to set the color of the unselected grip by selecting it from this
drop-down list or by selecting the Select Color option to display the Select Color dialog box.
You can select the color for the unselected grip from this dialog box. This color can also be set
using the GRIPCOLOR system variable.

Selected grip color
This drop-down list is used to set the color of the selected grip by selecting it from this drop-down
list or by selecting the Select Color option to display the Select Color dialog box. You can select
the color for the selected grip from this dialog box. This color can also be set using the GRIPHOT
system variable.

Hover grip color
This drop-down list is used to set the color of the hover grip color by selecting it from this
drop-down list or by selecting the Select Color option to display the Select Color dialog box.

Figure 6-5  The Selection tab of the Options dialog box
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You can select the color for the hover grip from this dialog box. This color can also be set using
the GRIPHOVER system variable.

The Grips area has three check boxes; Enable grips, Enable grips within blocks, and Enable
grip tips. The grips can be enabled by selecting the Enable Grips check box. They can also be
enabled by setting the GRIPS system variable to 1. The second check box, Enable grips within
blocks, enables the grips within a block. If you select this box, AutoCAD LT will display grips
for every object in the block. If you disable the display of grips within a block, the block will
have only one grip at its insertion point. You
can also enable the grips within a block by
setting the value of the GRIPBLOCK
system variable to 1 (On). If GRIPBLOCK is
set to 0 (Off), AutoCAD LT will display only
one grip for a block at its insertion point
(Figure 6-6). The third check box, Enable grip
tips, enables you to display the grip tips when
the cursor moves over the custom object that
supports grip tips. If you disable this check
box, the grip tips are not displayed when the
cursor moves over the custom object. You can
also enable the grip tips  by setting the value
of the GRIPTIPS system variable to 0 (Off).
If GRIPTIPS is set to 1 (On), AutoCAD LT
will display the grip tips for the custom object.

Note
If the block has a large number of objects, and if GRIPBLOCK is set to 1 (On), AutoCAD LT
will display grips for every object in the block. Therefore, it is recommended that you set the
system variable GRIPBLOCK to 0 or clear the Enable grips within blocks check box in the
Selection tab of the Options dialog box.

Object selection limit for display of grips
This text box is used to specify the maximum number of objects that can be selected at a single
attempt for the display of grips. If you select objects more than that specified in the text box
using a single selection method, the grips will not be displayed. Note that this limit is set only
for those objects that are selected at a single attempt using any of the Crossing, Window, Fence,
or All options.

EDITING OBJECTS WITH GRIPS
As mentioned earlier, you can perform different kinds of editing operations using the selected
grip. The editing operations are discussed next.

Stretching Objects With Grips (Stretch Mode)
If you select an object, AutoCAD LT displays the unselected grips at the definition points of the
object. When you select a grip for editing, you are automatically in the Stretch mode. The

Figure 6-6  Block insertion with GRIPBLOCK set
to 1 and to 0
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Stretch mode has a function similar to the STRETCH command. When you select a grip, it acts
as a base point and is called a base grip. You can also select several grips by holding the SHIFT
key down and then selecting the grips. Now, release the SHIFT key and select one of the hot
grips to stretch them simultaneously. The geometry between the selected base grips is not altered.
You can also make copies of the selected objects or define a new base point. When selecting grips
on text objects, blocks, midpoints of lines, centers of circles and ellipses, and point objects in
the stretch mode, the selected objects are moved to a new location. The following example
illustrates the use of the Stretch mode.

1. Use the PLINE command to draw a
W-shaped figure as shown in Figure 6-7(a).

2. Select the object that you want to stretch
[Figure 6-7(a)]. When you select the
object, grips will be displayed at the
endpoints of each object. A polyline has
two grip points. If you use the LINE
command to draw the object, AutoCAD
LT will display three grips for each object.

3. Hold the SHIFT key down, and select the
grips that you want to stretch [grips on
the lower endpoints of the two vertical
lines in Figure 6-7(b)]. The selected grips
will become hot grips, and the color will change from blue to red.

Note
You have to make sure that you hold the SHIFT key before selecting even the first grip. You cannot
hold the SHIFT key and select more grips if the first grip is selected without holding it.

4. Select one of the selected (hot grip) grips, and specify a point to which you want to stretch
the line [Figure 6-7(c)]. When you select a grip, the following prompt is displayed in the
Command prompt area.

**STRETCH**
Specify stretch point or [Base point/Copy/Undo/eXit]:

The Stretch mode has several options: Base point, Copy, Undo, and eXit. You can use the
Base point option to define the base point and the Copy option to make copies.

5. Select the grip where the two lines intersect. Right-click to display the shortcut menu
(Figure 6-8) and choose the Copy option. Select the points as shown in Figure 6-9(b). Each
time you select a point, AutoCAD LT will make a copy. You can also specify stretch points by
entering the numerical value in the dimensional input boxes in the drawing area. If you
press the CTRL key when specifying the point to which the object is to be stretched,
without selecting the copy option, then also AutoCAD LT allows you to make multiple

Figure 6-7  Using the Stretch mode to stretch
the lines
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copies of the selected object. Also, if you press the CTRL key again
when specifying the next point, the cursor snaps to a point whose
location is based on the distance between the first two points, that
is, the distance between the selected object and the location of the
copy of the selected object.

6. Make a copy of the drawing, as shown in Figure 6-9(c). Select the
object, and then select the grip where the two lines intersect. When
AutoCAD LT displays the **STRETCH** prompt, choose the Base
Point option from the shortcut menu or enter B at the Command
prompt. Select the bottom left grip as the base point, and then give
the displacement point, as shown in Figure 6-9(d).

7. To terminate the grip editing mode, right-click when the grip is
hot to display the shortcut menu and then select eXit. You can also
enter X at the Command prompt or press ESC to exit.

Note
You can select an option (Copy or Base Point) from the shortcut menu that can be invoked by
right-clicking your pointing device after selecting a grip. The different modes can also be selected
from the shortcut menu. You can also cycle through all the different modes by selecting a grip and
pressing the ENTER key or the SPACEBAR.

Moving Objects with Grips (Move Mode)
The Move mode lets you move the selected objects to a new location. When you move objects,
their size and angles do not change. You can also use this mode to make copies of the selected

Figure 6-9  Using the Stretch mode’s Copy and Base point options

Figure 6-8  Selecting
different Grip options
from the shortcut menu
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objects or to redefine the base point. The following example illustrates the use of the Move
mode.

1. Use the LINE command to draw the shape, as shown in Figure 6-10(a). When you select the
objects, grips will be displayed at the definition points and the object will be highlighted.

2. Select the grip located at the lower left corner and then choose Move from the shortcut
menu. You can also invoke the Move mode by  giving a null response by pressing the
SPACEBAR or ENTER key. AutoCAD LT will display the following prompt in the Command
prompt area:

**MOVE**
Specify move point or [Base point/Copy/Undo/eXit]:

3. Hold down the CTRL key, and then enter the first displacement point. The distance between
the first and the second object defines the snap offset for subsequent copies. While holding
down the CTRL key, move the screen crosshairs to the next snap point and select the point.
AutoCAD LT will make a copy of the object at this location. If you release the CTRL key, you
can specify any point where you want to place a copy of the object. You can also enter
coordinates to specify the displacement.

Rotating Objects with Grips (Rotate Mode)
The Rotate mode allows you to rotate objects around the base point without changing their size.
The options of the Rotate mode can be used to redefine the base point, specify a reference
angle, or make multiple copies that are rotated about the specified base point. You can access the
Rotate mode by selecting the grip and then selecting Rotate from the shortcut menu, or by

Figure 6-10  Using the Move mode to move and make copies of the
selected objects



Editing Sketched Objects-II                                                                             6-9

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. F
or

 e
ng

in
ee

ri
ng

 s
er

vi
ce

s,
 c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

giving a null response twice by pressing the SPACEBAR or the ENTER key. The following
example illustrates the use of the Rotate mode.

1. Use the LINE command to draw the shape, as shown in Figure 6-11(a). When you select the
objects, grips will be displayed at the definition points and the shape will be highlighted.

2. Select the grip located at the lower left corner and then invoke the Rotate mode. AutoCAD LT
will display the following prompt.

**ROTATE**
Specify a rotation angle or [Base point/Copy/Undo/Reference/eXit]:

3. At this prompt, enter the rotation angle. By default the rotation angle will be entered
through the dimensional input below the cursor in the drawing area.  AutoCAD LT will
rotate the selected objects by the specified angle [Figure 6-11(b)].

4. Make a copy of the original drawing, as shown in Figure 6-11(c). Select the objects, and then
select the grip located at its lower left corner. Invoke the Rotate mode and then select the
Copy option from the shortcut menu or enter C (Copy) at the Command prompt or the
Copy option from the selection preview. Enter the rotation angle. AutoCAD LT will rotate
the copy of the object through the specified angle [Figure 6-11(d)].

5. Make another copy of the object, as shown in Figure 6-12(a). Select it, and then select the
grip at point (P0). Access the Rotate mode and the copy option as described earlier. Select
the Reference option from the shortcut menu, enter R at the prompt sequence, or select the
Reference option from the selection preview. The prompt sequence is given next.

Figure 6-11  Using the ROTATE mode to rotate and make copies of
the selected objects
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**ROTATE (multiple) **
Specify rotation angle or [Base point/Copy/Undo/Reference/eXit]: R
Specify reference angle <0>: Select the grip at (P1).
Specify second point: Select the grip at (P2).
Specify new angle or [Base point/Copy/Undo/Reference/eXit]: 45

In response to the Specify reference angle <0>: prompt, select the grips at points (P1) and
(P2) to define the reference angle. When you enter the new angle, AutoCAD LT will rotate and
insert a copy at the specified angle [Figure 6-12(c)]. For example, if the new angle is 45-degree,
the selected objects will be rotated about the base point (P0) so that the line P1P2 makes a
45-degree angle with respect to the positive X axis.

Scaling Objects with Grips (Scale Mode)
The Scale mode allows you to scale objects with respect to the base point without changing their
orientation. The options of Scale mode can be used to redefine the base point, specify a reference
length, or make multiple copies that are scaled with respect to the specified base point. You can
access the Scale mode by selecting the grip and then selecting Scale from the shortcut menu, or
giving a null response three times by pressing the SPACEBAR or the ENTER key. The following
example illustrates the use of the Scale mode.

1. Use the PLINE command to draw the shape, as shown in Figure 6-13(a). When you select
the objects, they will be highlighted and the grips will be displayed at the definition points.

2. Select the grip located at the lower left corner as the base grip, and then invoke the Scale
mode. AutoCAD LT will display the following prompt in the Command prompt area.

Figure 6-12  Using the ROTATE mode to rotate by giving a reference
angle
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**SCALE**
Specify scale factor or [Base point/Copy/Undo/Reference/eXit]:

3. At this prompt, enter the scale factor or move the cursor and select a point to specify a new
size. AutoCAD LT will scale the selected objects by the specified scale factor [Figure 6-13(b)].
If the scale factor is less than 1 (<1), the objects will be scaled down by the specified factor.
If the scale factor is greater than 1 (>1), the objects will be scaled up.

4. Make a copy of the original drawing, as shown in Figure 6-13(c). Select the objects, and then
select the grip located at their lower left corner. Invoke the Scale mode. At the following
prompt, enter C (Copy), and then enter B for the base point.

**SCALE (multiple) **
Specify scale factor or [Base point/Copy/Undo/Reference/eXit]: B

5. At the Specify base point prompt, select the point (P0) as the new base point, and then
enter R at the following prompt.

**SCALE (multiple) **
Specify scale factor or [Base point/Copy/Undo/Reference/eXit]: R
Specify reference length <1.000>: Select grips at (P1) and (P2).

After specifying the reference length at the Specify new length or [Base point/Copy/Reference/
eXit] prompt, enter the actual length of the line. AutoCAD LT will scale the objects so that the
length of the bottom edge is equal to the specified value [Figure 6-13(c)].

Figure 6-13  Using the SCALE mode to scale and make copies of
the selected objects
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Mirroring Objects with Grips (Mirror Mode)
The Mirror mode allows you to mirror the objects across the mirror axis without changing their
size. The mirror axis is defined by specifying two points. The first point is the base point, and
the second point is the point that you select when AutoCAD LT prompts for the second point.
The options of the Mirror mode can be used to redefine the base point and make a mirror copy
of the objects. You can access the Mirror mode by selecting a grip and then choosing Mirror
from the shortcut menu, or giving a null response four times by pressing the SPACEBAR or the
ENTER key. The following is the example for the Mirror mode.

1. Use the PLINE command to draw the shape, as shown in Figure 6-14(a). When you select
the object, grips will be displayed at the definition points and the object will be highlighted.

2. Select the grip located at the lower right corner (P1), and then invoke the Mirror mode. The
following prompt is displayed.

**MIRROR**
Specify second point or [Base point/Copy/Undo/eXit]:

3. At this prompt, enter the second point (P2). AutoCAD LT will mirror the selected objects
with line P1P2 as the mirror axis, as shown in Figure 6-14(b).

4. Make a copy of the original figure as shown in Figure 6-14(c). Select the object, and then
select the grip located at its lower right corner (P1). Invoke the Mirror mode and then
choose the Copy option to make a mirror image while retaining the original object.
Alternatively, you can also hold down the SHIFT key and make several mirror copies by
specifying the second point.

Figure 6-14  Using the MIRROR mode to create a mirror image of
the selected objects
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5. Select point (P2) in response to the prompt Specify second point or [Base point/Copy/
Undo/eXit]. AutoCAD LT will create a mirror image, and the original object will be retained.

Note
You can use some editing commands such as ERASE, MOVE, ROTATE, SCALE, MIRROR,
and COPY on an object with unselected grips. However, this is possible only if the PICKFIRST
system variable is set to 1 (On).

You cannot select an object when the grip is hot.

To remove an object from the selection set displaying grips, press the SHIFT key and then select
the particular object. This object, which is removed from the selection set, will no longer be
highlighted.

LOADING HYPERLINKS
If you have already added a hyperlink to the object, you can also use the grips to open a file
associated with it. For example, the hyperlink could start a word processor, or activate the Web
browser and load a Web page that is embedded in the selected object. To launch the Web browser
that provides hyperlinks to other Web pages, select the URL-embedded object and then right-click
to display the shortcut menu. In the shortcut menu, choose the Hyperlink > Open option and
AutoCAD LT will automatically load the Web browser. When you move the cursor over or near
the object that contains a hyperlink, AutoCAD LT displays the hyperlink information with the
cursor.

EDITING GRIPPED OBJECTS
You can also edit the properties of the gripped objects by using the Properties toolbar, see
Figure 6-15. The gripped objects are created when you select objects without invoking a command.
The gripped objects are highlighted and will display grips (rectangular boxes) at their grip
points. For example, to change the color of the gripped objects, select the Color drop-down list
in the Properties toolbar and then select a color. The color of the gripped objects will change
to the selected color. Similarly, to change the layer, lineweight, or linetype of the gripped
objects, select the linetype, lineweight, or layer from the corresponding drop-down lists. If the
gripped objects have different colors, linetypes, or lineweights, the Color Control, Linetype
Control, and Lineweight Control boxes will appear blank. You can also change the plot style of
the selected objects using this toolbar.

Figure 6-15  Using the Properties toolbar to change properties of the gripped objects
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CHANGING PROPERTIES USING THE PROPERTIES
PALETTE

As mentioned earlier, each object has a number of
properties associated to it such as the color, layer,
linetype, line weight, and so on. You can modify

the properties of an object by using the PROPERTIES
command. When you invoke this command, AutoCAD LT
will display the PROPERTIES palette, see Figure 6-16.
The PROPERTIES palette can also be displayed when
you double-click on the object to be edited. The contents
of the PROPERTIES palette change according to the
objects selected. For example, if you select a text entity,
the related properties such as its height, justification,
style, rotation angle, obliquing factor, and so on, will be
displayed.

The PROPERTIES palette can also be invoked from the
shortcut menu displayed when you right-click in the drawing
area. Choose the Properties option to display the
PROPERTIES palette. If you select more than one object,
the common properties of the selected objects will be
displayed in the PROPERTIES palette. To change the
properties of the selected objects, click in the cell next to the name of the property and change
the values manually. Alternatively you can choose from the available options in the drop-down
list, if one is available. You can cycle through the options by double-clicking in the property cell.

Note
Some of the options of the PROPERTIES palette have been explained in Chapter 4. Other
options will be explained in detail in Chapter 18.

CHANGING PROPERTIES USING GRIPS
You can also use the grips to change the properties of a single or multiple object. To change
the properties , select the object to display the grips and then right-click to display the shortcut
menu. Choose the Properties option to display the PROPERTIES palette. If you select a
circle, AutoCAD LT will display Circle in the No selection drop-down list on the upper left
corner of the PROPERTIES palette. Similarly, if you select text, Text is displayed in the
drop-down list. If you select several objects, AutoCAD LT will display all the objects in the
selection drop-down list of the PROPERTIES palette. You can use this palette to change the
properties (color, layer, linetype, linetypes scale, lineweight, thickness, and so on) of
the gripped objects.

Toolbar: Standard > Properties
Menu: Modify > Properties
Command: PROPERTIES

Figure 6-16 The PROPERTIES
palette for editing the properties of the



Editing Sketched Objects-II                                                                             6-15

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. F
or

 e
ng

in
ee

ri
ng

 s
er

vi
ce

s,
 c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

MATCHING PROPERTIES OF THE SKETCHED OBJECTS

The MATCHPROP command can be used to change some properties like color, layer,
linetype, and linetype scale of the selected objects. However, in this case, you need a
source object whose properties will be forced on the destination objects. When you

invoke this command, AutoCAD LT will prompt you to select the source object and then the
destination objects. The properties of the destination objects will be changed to that of the
source object. This command is a transparent command and can be used inside another command.
The prompt sequence that will follow when you choose the Match Properties button from the
Standard toolbar is given next.

Select Source Object: Select the source object.
Current active settings: Color Layer Ltype Ltscale Lineweight Thickness PlotStyle Text Dim
Hatch Polyline Viewport
Select destination object(s) or [Settings]:

If you select the destination object in the Select destination object(s) or [Settings] prompt, the
properties of the source object will be forced on it. If you select the Settings option, AutoCAD LT
displays the Property Settings dialog box (Figure 6-17). The properties displayed are those of
the source object. You can use this dialog box to edit the properties that are copied from the
source to destination objects.

Toolbar: Standard > Match Properties
Menu: Modify > Match Properties
Command: MATCHPROP

Figure 6-17  The Property Settings dialog box
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Menu: Tools > Quick Select
Command: QSELECT

QUICK SELECTION OF THE SKETCHED OBJECTS

The QSELECT command creates a new selection set that will either include or exclude all
objects that match the specified object type and property criteria. The QSELECT command can
be applied to the entire drawing or existing selection set. If a drawing is partially opened,
QSELECT does not consider the objects that are not loaded. The QSELECT command can be
invoked by choosing the Quick Select button in the Properties palette. In the shortcut menu,
the QSELECT command can be invoked by choosing Quick Select. When you invoke this
command, the Quick Select dialog box will be displayed, see Figure 6-18. The Quick Select
dialog box specifies the object filtering criteria and creates a selection set from it.

Apply to
The Apply to drop-down list specifies whether to apply the filtering criteria to the entire drawing
or to the current selection set. If there is an existing selection set, the Current selection is the

Figure 6-18  The Quick Select dialog box
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default value. Otherwise the entire drawing is the default value. You can select the objects to
create a selection set by choosing the Select objects button on the right side of this drop-down
list. The Quick Select dialog box is temporarily closed when you choose this button and you will
be prompted to select the objects. The dialog box will be redisplayed once a selection set is
made.

Object type
This drop-down list specifies the type of object to be filtered. It lists all the available object types
and if some objects are selected, it lists all the selected object types. Multiple is the default
setting.

Properties
This list box displays the properties to be filtered. All the properties related to the object type
will be displayed in this list box. The property selected from this list box will define the options
that will be available in the Operator and Value drop-down list.

Operator
This drop-down list specifies the range of the filter for the chosen property. The filters that are
available are given next.

• Equals =
• Not Equal <>
• Greater than >
• Less than <
• Select All
• Wildcard Match (For Hyperlink property)

Note
The Value drop-down list will not be available when you select Select All from the Operator
drop-down list.

Value
This drop-down list specifies the property value of the filter. If the values are known, it
becomes a list of the available values from which you can select a value. Otherwise, you can
enter a value.

How to apply Area
The options under this area are used to specify whether the filtered entities will be included or
excluded from the new selection set. This area provides the following two radio buttons.

Include in new selection set
If this radio button is selected, the filtered entities will be included in the new selection set. If
selected, this radio button creates a new selection set composed only of those objects that conform
to the filtering criteria.
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Toolbar: Standard > DesignCenter
Menu: Tools > DesignCenter
Command: ADCENTER

Exclude from new selection set
If this radio button is selected, the filtered entities will be excluded from the new selection set.
This radio button creates a new selection set of objects that do not conform to the filtering
criteria.

Append to current selection set
This creates a cumulative selection set by using multiple uses of Quick Select. It specifies whether
the objects selected using the QSELECT command replace the current selection set or append
the current selection set.

Tip
Quick Select supports custom objects (objects that are created by some other applications) and
their properties. If custom objects have properties other than AutoCAD LT, then the source
application of the object should be running for the properties to be available by the QSELECT.

MANAGING CONTENTS USING THE DESIGNCENTER

The DESIGNCENTER window is used to locate and organize drawing data, and to
insert blocks, layers, external references, and other customized drawing content. These
contents can be selected from either your own files, local drives, a network, or the

Internet. You can even access and use the contents between the files or from the Internet. You can
use the DESIGNCENTER to conveniently drag and drop any information that has been previously
created into the current drawing. This powerful tool reduces the repetitive tasks of creating
information that already exists. To invoke the DESIGNCENTER window, choose the
DesignCenter button from the Standard toolbar. The  DESIGNCENTER window is displayed,
see Figure 6-19.

This window can be moved to any location on the screen by picking and dragging it with the
grab bar located on the left of the window. You can also resize it by clicking the borders and
dragging them to the right or left. Right-clicking on the title bar of the window displays a
shortcut menu that gives the options to move, resize, close, dock, and hide the DESIGNCENTER
window. The Auto-Hide button on the grab bar acts as a toggle for hiding and displaying the
DESIGNCENTER. Also, double-clicking on the title bar of the window docks the
DESIGNCENTER window if it is undocked and vice versa. To use this option, make sure that
the Allow Docking option is selected from the shortcut menu that is displayed by right-clicking
on the grab bar.

Note
The DESIGNCENTER can be turned on and off by pressing the CTRL+2 keys.
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Figure 6-20 shows the DESIGNCENTER toolbar buttons. When you choose the Tree View
Toggle button on the DESIGNCENTER  toolbar, it displays the Tree View (Left Pane) with a
tree view of the contents of the drives. If the tree view is not displayed, you can also right-click
in the window and choose Tree from the shortcut menu that is displayed. Now, the window is
divided into two parts, the Tree View (left pane) and the Palette (right pane). The Palette
displays folders, files, objects in a drawing, images, Web-based content, and custom content.
You can also resize both the Tree View and the Palette by clicking and dragging the bar between
them to the right or the left.

The DESIGNCENTER has four tabs provided below the DESIGNCENTER toolbar buttons.
They are Folders, Open drawings, History, and DC Online. The description of these tabs is
given next.

Folders Tab
The Folders tab lists all the folders and files in the local and network drives. When this tab is

Figure 6-20  The DESIGNCENTER toolbar buttons

Figure 6-19  The DESIGNCENTER window
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Figure 6-21 The DESIGNCENTER displaying Tree pane, Palette, Preview pane, and the
Description box

selected, the Tree View displays the tree view of the contents of the drives and the Palette
displays the various folders, and files in a drawing, images, and the Web-based content in the
selected drive.

In the Tree View, you can browse the contents of any folder by clicking on the plus sign (+)
adjacent to it to expand the view. Further, expanding the contents of a file, displays the
categories such as Blocks, Dimstyles, Layers, Layouts, Linetypes, Textstyles, and Xrefs.
Clicking on any one of these categories in the Tree View displays the listing under the selected
category in the Palette (Figure 6-21). Alternately, right-clicking a particular folder, file, or category
of the file contents displays a shortcut menu.

The Explore option in this shortcut menu also further expands the selected folder, file, or
category of contents to display the listing of the contents respectively. Choosing the Preview
button from the toolbar displays an image of the selected object or file in a Preview pane below
the Palette. Choosing the Description button displays a brief text description of the selected
item, if it has one in the Description box. When you click on a specific block name in the
palette, its preview image and description that was defined earlier when creating the block are
displayed in the Preview pane and the Description box, respectively.

You can drag and drop any of the contents into the current drawing, or add them by
double-clicking on them. These are then reused as part of the current drawing. When you
double-click on specific Xrefs and blocks, AutoCAD LT displays the External Reference dialog
box and the Insert dialog box, respectively, to help in attaching the external reference and
inserting the block, respectively. Right-clicking a block displays the options of  Insert Block,
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Copy, or Create Tool Palette and right-clicking an Xref displays the options of Attach Xref or
Copy in the shortcut menus. Similarly, when you double-click a layer, text style, dimstyle, layout,
or linetype style, they also get added to the current drawing. If any of these named objects
already exist in the current drawing, duplicate definition is ignored and it is not added again.
When you right-click on a specific linetype, layer, textstyle, layout, or dimstyle in the palette, a
shortcut menu is displayed that gives you an option to Add or Copy. The Add option directly
adds the selected named object to the current drawing. The Copy option copies the specific
named object to the clipboard from where you can paste it into a particular drawing.

Note
You will learn more about inserting blocks in Chapter 14, Working with Blocks.

Right-clicking a particular folder or file in the Tree View displays a shortcut menu. The various
options in the shortcut menu, besides those discussed earlier, are Add to Favorites, Organize
Favorites, Create Tool Palette, and Set as Home. Add to Favorites adds the selected file or
folder to the Favorites folder, which contains the most often accessed files and folders. Organize
Favorites allows you to reorganize the contents of the Favorites folder. When you select Organize
Favorites from the shortcut menu, the Autodesk folder is opened in a window. Create Tool
Palette adds the blocks of the selected file or folder to the TOOL PALETTES window, which
contains the predefined blocks. Set as Home sets the selected file or folder as the Home folder.
You will notice that when the Design Center command is invoked the next time, the file that was
last set as the Home folder is displayed selected in the DESIGNCENTER.

Open Drawings Tab
The Open Drawings tab lists all the drawings that are open, including the current drawing
which is being worked on. When you select this tab, the Tree View (left pane) displays the tree
view of all the drawings that are currently open and the Palette (right pane) displays the
various contents in the selected drawing.

History Tab
The History tab lists the most recent locations accessed through the DESIGNCENTER. When
you select this tab, the Tree View (left pane) and the Palette (right pane) are replaced by a list
box. Right-clicking a particular file displays a shortcut menu. The various options in the shortcut
menu are Explore, Folders, Open Drawings, Delete, and Search. The Explore option invokes
the Folders tab of the DESIGNCENTER with the file selected in the Tree View and the contents
in the selected file displayed in the Palette View. The Folders option invokes the Folders tab of
the DESIGNCENTER. The Open Drawings option invokes the Open Drawings tab of the
DESIGNCENTER. The Delete option deletes the selected drawing from the History list. The
Search option allows you to search for drawings or named objects such as blocks, textstyles,
dimstyles, layers, layouts, external references, or linetypes.

DC Online Tab
The DC Online tab allows you to download the symbols, information regarding various
manufacturer’s products, and the online catalogs of various products from the DesignCenter
Online window. To access the DesignCenter Online, after establishing the Web connection,



6-22                                                                                              AutoCAD LT 2006 for Designers
©

 C
A

D
C

IM
 T

ec
hn

ol
og

ie
s,

 U
S

A
. F

or
 o

nl
in

e 
tr

ai
ni

ng
, c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

Example 1 Architectural

choose the Reconnect to DesignCenter button. In the DesignCenter Online window, the Tree
View displays various folders under the Standard Parts, Manufactures, and the Aggregators
heading. You can select the desired folder from the Tree View and the contents available in the
selected folder are displayed on the Palette. The preview and the description of the selected
content are displayed in the Preview window. You can double-click or drag and drop the selected
content from the Web page in the current drawing.

Choosing the Back button in the DESIGNCENTER toolbar displays the last item selected in
the DESIGNCENTER. If you pick the down arrow on the Back button, a list of the five recently
visited items is displayed. You can view the desired item in the DESIGNCENTER by selecting
it from the list. The Forward button is available only if you have chosen the Back button once.
This button displays the same page as the current page before you choose the Back button. The
Up button moves one level up in the tree structure from the current location. Choosing the
Favorites button displays shortcuts to files and folders that are accessed frequently by you and
are stored in the Favorites folder. This reduces the time you take to access these files or folders
from their normal location. Choosing the Tree View Toggle button in the DESIGNCENTER
toolbar displays or hides the tree pane with the tree view of the contents in a hierarchial form.
Choosing the Load button displays the Load dialog box, whose options are similar to those of
the standard Select file dialog box. When you select a file here and choose the Open button,
AutoCAD LT displays the selected file and its contents in the DESIGNCENTER.

The Views button gives four display format options for the contents of the palette: Large icons,
Small icons, List, and Details. The List option lists the contents in the palette, while the
Details option gives a detailed list of the contents in the palette with the name, file size, and type.

Right-clicking in the palette displays a shortcut menu with all the options provided in the
DESIGNCENTER in addition to the Add to Favorites, Organize favorites,  Refresh, and
Create Tool Palette of Blocks options. The Refresh option refreshes the palette display if you
have made any changes to it. The Create Tool Palette of Blocks option adds the drawings of the
selected file or folder to the TOOL PALETTES, which contains the predefined blocks The
following example will illustrate how to use the DESIGNCENTER to locate a drawing and then
use its contents into a current drawing.

Use the DESIGNCENTER to locate and view the contents of the drawing Kitchens.dwg. Also,
use the DESIGNCENTER to insert a block from this drawing and import a layer and a textstyle
from the Hotel Model.dwg file located in the Sample folder. Use these to make a drawing of a
Kitchen plan (MyKitchen.dwg) and then add text to it, as shown in Figure 6-22.

1. Open a new drawing using the Start from Scratch option. Make sure to select the Imperial
(feet and inches) option in the Create New Drawing dialog box.

2. Change the units to Architectural using the Drawing Units dialog box. Increase the limits
to 10',10'. Invoke the ALL option of the ZOOM command to increase the drawing display
area.
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3. Choose the DesignCenter button from the Standard toolbar; the DESIGNCENTER window
is displayed at its default location.

4. In the DESIGNCENTER toolbar, choose the Tree View Toggle button to display the Tree
View and the Palette (if not already displayed). Also, choose the Preview button. You can
resize the window, if need be, to view both the Tree View and the Palette, conveniently.

5. Choose the Search button in the DESIGNCENTER to display the Search dialog box.
Here, select Drawings from the Look for drop-down list and C: (or the drive in which
AutoCAD LT 2006 is installed) from the In drop-down list. Select the Search subfolders
check box. In the Drawings tab, type Kitchens in the Search for the word(s) edit box and
select File Name from the In the field(s) drop-down list. Now, choose the Search Now
button to commence the search. After the drawing has been located, its details and path are
displayed in a list box at the bottom of the dialog box.

6. Now, right-click on Kitchens.dwg in the list box of the Search dialog box and choose Load
into Content Area from the shortcut menu. You will notice that the drawing and its contents
are displayed in the Tree view.

7. Close the Search dialog box.

8. Double-click on Kitchens.dwg in the Tree View to expand the tree view and display its
contents, in case they are not displayed. You can also expand the contents by clicking on
the + sign located on the left of the file name in the Tree view.

9. Select Blocks in the Tree View to display the list of blocks in the drawing in the Palette.
Using the left mouse button, drag and drop the block Kitchen Layout-7x8 ft in the current
drawing.

Figure 6-22  Drawing for Example 1
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10. Now, double-click on the Hotel Model.dwg file located in the Sample folder in the same
directory to display its contents in the Palette.

11. Select Layers in the Tree View to display the layers in the drawing. Drag and drop or
double-click the layer 7BRIDGE from the Palette to the current drawing. Now, you can use
this layer for placing the text in the current drawing after making it the current layer.

12. Select Textstyles to display the list of text styles in the Palette. Select ITALICA in the
Palette and drag and drop it in the current drawing. You can use this textstyle for adding
text to the current drawing.

13. Use the imported data to add text to the current drawing and complete it, as shown
in Figure 6-22.

14. Save the current drawing as MyKitchen.dwg.

MAKING INQUIRIES ABOUT OBJECTS AND DRAWINGS
When you create a drawing or examine an existing one, you often need some information about
it. In manual drafting, you can inquire about the drawing by performing measurements and
calculations manually. Similarly, when drawing in an AutoCAD LT environment, you will need
to make inquiries about the data pertaining to your drawing. The inquiries can be about the
distance from one location on the drawing to another, the area of an object like a polygon or
circle, coordinates of a location on the drawing, and so on. AutoCAD LT keeps track of all these
details. Since inquiry commands are used to obtain information about the selected objects, they
do not affect the drawings in any way. The following is the list of Inquiry commands:

AREA DIST ID LIST DBLIST
STATUS TIME DWGPROPS MASSPROP

Note
The MASSPROP command will be discussed in Chapter 25.

For most of the Inquiry commands, you are prompted to select objects; once the selection is
complete, AutoCAD LT switches from the graphics mode to the text mode, and all the
relevant information about the selected objects is displayed. For some commands, information
is displayed in the AutoCAD LT Text Window. The display of the text screen can be tailored to
your requirements using a pointing device. Therefore, by moving the text screen to one side,
you can view the drawing screen and the text screen, simultaneously. If you select the minimize
button or select the close button, you will return to the graphics screen. You can also return to the
graphics screen by entering the GRAPHSCR command at the Command prompt. Similarly,
you can return to the AutoCAD LT Text Window by entering TEXTSCR at the Command
prompt.
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Measuring Area of Objects

Finding the area of a shape or an object manually is time-consuming. In AutoCAD LT,
the AREA command is used to automatically calculate the area of an object in square
units. This command saves time when calculating the area of shapes, especially when

the shapes are complicated or irregular.

You can use the default option of the AREA
command to calculate the area and perimeter
or circumference of the space enclosed by the
sequence of specified points. For example, to
find the area of an object (one which is not
formed of a single object) you have created
with the help of the LINE command
(Figure 6-23), you need to select all the vertices
of that object. By selecting the points, you
can define the shape of the object whose area
is to be found. This is the default method
for determining the area of an object. The only
restriction is that all the points you specify
should be in a plane parallel to the XY plane of the current UCS. You can make the best possible
use of the object snaps such as the ENDpoint, INTersect, and TANgent, or even use running
Osnaps, to help you select the vertices quickly and accurately. For AutoCAD LT, to find the area
of a shape, the shapes need not have been drawn with polylines; nor do the lines need to be
closed. However, curves must be approximated with short straight segments. In such cases,
AutoCAD LT computes the area by assuming that the first point and the last point are joined.
The prompt sequence that will follow when you choose the Area button from the Inquiry
toolbar is given next.

Specify first corner point or [Object/Add/Subtract]: Specify first point.
Specify next corner point or press ENTER for total: Specify the second point.
Specify next corner point or press ENTER for total: Continue selecting until all the points
enclosing the area have been selected.
Specify next corner point or press ENTER for total: �
Area = X, Perimeter = Y

Here, X represents the numerical value of the area and Y represents the circumference/perimeter.
It is not possible to accurately determine the area of a curved object, such as an arc, with the
default (Point) option. However, the approximate area under an arc can be calculated by specifying
several points on the given arc. If the object whose area you want to find is not closed (formed of
independent segments) and has curved lines, you should use the following steps to determine
the accurate area of such an object.

Figure 6-23  Using the AREA command

Toolbar: Inquiry > Area
Menu: Tools > Inquiry > Area
Command: AREA
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1. Convert all the segments in that object into polylines using the PEDIT command.
2. Join all the individual polylines into a single polyline. Once you have performed these

operations, the object becomes closed and you can then use the Object option of the AREA
command to determine the area.

If you specify two points on the screen, the AREA command will display the value of the area as
0.00; the perimeter value is the distance between the two points.

Object Option
You can use the Object option to find the area of objects such as polygons, circles, polylines,
regions, solids, and splines. If the selected object is a polyline or polygon, AutoCAD LT displays
the area and perimeter of the polyline. In case of open polylines, the area is calculated assuming
that the last point is joined to the first point but the length of this segment is not added to the
polyline length, unlike the default option. If the selected object is a circle, ellipse, or planar
closed spline curve, AutoCAD LT will provide information about its area and circumference. For
a solid, the surface area is displayed. For a 3D polyline, all vertices must lie in a plane parallel
to the XY plane of the current UCS. The extrusion direction of a 2D polyline whose area you
want to determine should be parallel to the Z axis of the current UCS. In case of polylines which
have a width, the area and length of the polyline are calculated using the centerline. If any of
these conditions is violated, an error message is displayed on the screen. The following
prompt sequence appears when you choose the Area button.

Specify first corner point or [Object/Add/Subtract]: O �
Select objects : Select an object �
Area = (X), Perimeter = (Y)

X represents the numerical value of the area, and Y represents the circumference/perimeter.

Tip
In many cases, the easiest and most accurate way to find the area of an region enclosed by
multiple objects is to use the BOUNDARY command to create a polyline, and then use the
AREA Object option.

Add Option
Sometimes you want to add areas of different objects to determine a total area. For example, in
the plan of a house, you need to add the areas of all the rooms to get the total floor area. In such
cases, you can use the Add option. Once you invoke this option, AutoCAD LT activates the Add
mode. By using the First corner point option at the Specify first corner point or [Object/Subtract]
prompt, you can calculate the area and perimeter by selecting points on the screen. Pressing
ENTER, after you have selected the points defining the area that is to be added, calculates the
total area, since the Add mode is on. The command prompt is as follows:

Specify next corner point or press ENTER for total [ADD mode]:

If the polygon whose area is to be added is not closed, the area and perimeter are calculated
assuming that a line that connects the first point to the last point is added to close the polygon.
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The length of this area is added in the perimeter. The Object option adds the areas and
perimeters of selected objects. While using this option, if you select an open polyline, the area
is calculated considering the last point is joined to the first point but the perimeter does not
consider the length of this assumed segment, unlike the First corner point option. When you
select an object, the area of the selected object is displayed on the screen. At this time the total
area is equal to the area of the selected object. When you select another object, AutoCAD LT
displays the area of the selected object as well as the combined area (total area) of the previous
object and the currently selected object. In this manner, you can add areas of different objects.
Until the Add mode is active, the string ADD mode is displayed along with all subsequent
object selection prompts to remind you that the Add mode is active. When the AREA command
is invoked, the total area is initialized to zero.

Subtract Option
The action of the Subtract option is the reverse of that of the Add option. Once you invoke this
option, AutoCAD LT activates the Subtract mode. The First corner point and Object options
work similar to the way they work in the ADD mode. When you select an object, the area of the
selected object is displayed on the screen. At this time, the total area is equal to the area of the
selected object. When you select another object, AutoCAD LT displays the area of the selected
object, as well as the area obtained by
subtracting the area of the currently selected
object from the area of the previous object. In
this manner, you can subtract areas of objects
from the total area. Until the Subtract mode
is active, the string SUBTRACT mode is
displayed, along with all subsequent object
selection prompts, to remind you that the
Subtract mode is active. To exit the AREA
command, press ENTER (null response) at the
Specify first corner point or [Object/Add/
Subtract] prompt. The prompt sequence for
these two modes for Figure 6-24 is given next.

Specify first corner point or [Object/
Add/Subtract]: A �
Specify first corner point or [Object/Subtract]: O �
(ADD mode) Select objects: Select the polyline.
Area = 2.4438, Perimeter = 6.4999
Total area = 2.4438
(ADD mode) Select objects: �
Specify first corner point or [Object/Subtract]: S �
Specify first corner point or [Object/Add]: O �
(SUBTRACT mode) Select object: Select the circle.
Area = 0.0495, Circumference = 0.7890
Total area = 2.3943
(SUBTRACT mode) Select objects: Select the second circle.
Area = 0.0495, Circumference = 0.7890

Figure 6-24  Measuring the area of a sketch using
the Add and Subtract options
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Total area = 2.3448
(SUBTRACT mode) Select object: �
Specify first corner point or [Object/Add]: �

The AREA and PERIMETER system variables hold the area and perimeter (or circumference
in the case of circles) of the previously selected polyline (or circle). Whenever you use the AREA
command, the AREA variable is reset to zero.

Tip
If an architect wants to calculate the area of flooring and skirting in a room, the Area
command provides you with its area and the perimeter. You can use these parameters to calculate
the skirting.

Measuring the Distance Between Two Points

The DIST command is used to measure the distance between two selected points, as
shown in Figure 6-25. The angles that the selected points make with the X axis and the
XY plane are also displayed. The measurements are displayed in the current units. Delta

X (horizontal displacement), delta Y (vertical displacement), and delta Z are also displayed. The
distance computed by the DIST command is saved in the DISTANCE variable.

The prompt sequence that will follow when you choose the Distance button is given next.

Specify first point: Specify a point.
Specify second point: Specify a point.

Figure 6-25  Using the DIST command

Toolbar: Inquiry > Distance
Menu: Tools > Inquiry > Distance
Command: DIST
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AutoCAD LT returns the following information.

Distance = Calculated distance between the two points.
Angle in XY plane = Angle between the two points in the XY plane.
Angle from XY plane = Angle the specified points make with the XY plane.
Delta X = Change in X, Delta Y = Change in Y, Delta Z = Change in Z.

If you enter a single number or fraction at the Specify first point prompt, AutoCAD LT will
convert it into the current unit of measurement and display it in the command line.

Command: DIST
First point: 3-3/4   (Enter a number or a fraction.)
Distance = 3.7500

Note
The Z coordinate is used in 3D distances. If you do not specify the Z coordinates of the two points
between which you want to know the distance, AutoCAD LT takes the current elevation as the Z
coordinate value.

Identifying the Location of a Point on the Screen

The ID command is used to identify the position of a point you specify by displaying
the X, Y, and Z coordinates of the point. The prompt sequence that will follow, when
you choose the Locate Point button from the Inquiry toolbar is given next.

Specify point: Specify the point to be identified.
X = X coordinate Y = Y coordinate  Z = Z coordinate

AutoCAD LT takes the current elevation as the Z coordinate value. If an Osnap mode is used to
snap to a 3D object in response to the Specify point prompt, the Z coordinate displayed will be
that of the selected feature of the 3D object. You can also use the ID command to identify the
location on the screen. This can be realized by entering the coordinate values you want to locate
on the screen. AutoCAD LT identifies the point by drawing a blip mark at that location, if the
BLIPMODE system variable is on. For example, the following is the prompt sequence to find
where the position X = 2.345, Y = 3.674, and Z = 1.0000 is located on the screen.

Specify point: 2.345,3.674,1.00 �
X = 2.345   Y = 3.674   Z = 1.0000

The coordinates of the point specified in the ID command are saved in the LASTPOINT
system variable. You can locate a point with respect to the ID point by using the relative or polar
coordinate system. You can also snap to this point by typing @ when AutoCAD LT prompts for
a point.

Toolbar: Inquiry > Locate Point
Menu: Tools > Inquiry > ID Point
Command: ID
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Listing Information About Objects

The LIST command displays all the information pertaining to the selected objects. The
information is displayed in the AutoCAD LT Text Window. The prompt sequence that
follows, when you choose the List button from the Inquiry toolbar is given next.

Select objects: Select objects whose data you want to list.
Select objects: �

Once you select the objects to be listed, AutoCAD LT shifts you from the graphics screen to the
AutoCAD LT Text Window. The information displayed (listed) varies from object to object. The
information on an object’s type, its coordinate position with respect to the current UCS (user
coordinate system), the name of the layer on which it is drawn, and whether the object is in
model space or paper space is listed for all types of objects. If the color, lineweight, and the
linetype are not BYLAYER, they are also listed. Also, if the thickness of the object is greater than
0, that is also displayed. The elevation value is displayed in the form of a Z coordinate (in the
case of 3D objects). If an object has an extrusion direction different from the Z axis of the
current UCS, the object’s extrusion direction is also provided.

More information based on the objects in the drawing is also provided. For example, for a line,
the following information is displayed.

1. The coordinates of the endpoints of the line.
2. Its length (in 3D).
3. The angle made by the line with respect to the X axis of the current UCS.
4. The angle made by the line with respect to the XY plane of the current UCS.
5. Delta X, Delta Y, Delta Z: this is the change in each of the three coordinates from the start

point to the endpoint.
6. The name of the layer in which the line was created.
7. Whether the line is drawn in Paper space or Model space.

The center point, radius, true area, and circumference of circles is displayed. For polylines, this
command displays the coordinates. In addition, for a closed polyline, its true area and perimeter
are also given. If the polyline is open, AutoCAD LT lists its length and also calculates the area by
assuming a segment connecting the start point and endpoint of the polyline. In the case of wide
polylines, all computation is done based on the centerlines of the wide segments. For a selected
viewport, the LIST command displays whether the viewport is on and active, on and inactive, or
off. Information is also displayed about the status of Hideplot and the scale relative to paper
space. If you use the LIST command on a polygon mesh, the size of the mesh (in terms of M, X,
N), the coordinate values of all the vertices in the mesh, and whether the mesh is closed or open
in M and N directions, are all displayed. As mentioned before, if all the information does not fit
on a single screen, AutoCAD LT pauses to allow you to press ENTER to continue the listing.

Toolbar: Inquiry > List
Menu: Tools > Inquiry > List
Command: LIST
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Checking Time-Related Information

The time and date maintained by your system are used by AutoCAD LT to provide information
about several time factors related to the drawings. Hence, you should be careful about setting the
current date and time in your computer. The TIME command can be used to display information
pertaining to time related to a drawing and the drawing session. The display obtained by invoking
the TIME command is similar to the following:

Command: TIME
Current time:               Tuesday, April 05, 2005 at 6:59:41:157 PM
Times for this drawing:
Created:                      Tuesday, April 05, 2005 at 3:51:19:396 PM
Last updated:               Tuesday, April 05, 2005 at 3:51:19:396 PM
Total editing time:        0 days 03:08:22.522
Elapsed timer (on):       0 days 03:08:21.961
Next automatic save in: 0 days 00:37:11.432

Enter option [Display/ON/OFF/Reset]: Enter the required option.

Displaying Drawing Properties

The DWGPROPS command displays information about the drawing properties. On choosing
Drawing Properties from the File Menu, the Drawing Properties dialog box is displayed, as
shown in Figure 6-26. This dialog box has four tabs under which information about the drawing
is displayed. This information helps you look for the drawing more easily. The tabs are as
follows.

General
This tab displays general properties about the drawing like the Type, Size, and Location.

Summary
The Summary tab displays predefined properties like the Author, title, and subject.

Statistics
This tab stores and displays data such as the file size and data such as the dates when the
drawing was last saved or modified.

Custom
This tab displays custom file properties including values assigned by you.

Menu: Tools > Inquiry > Time
Command: TIME

Menu: File > Drawing Properties
Command: DWGPROPS
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Answer the following questions, and then compare your answers to those given at the end of
this chapter.

1. The number of grips depends on the selected object. (T/F)

2. You can use the Options dialog box to modify the grips parameters. (T/F)

3. You need at least one source object while using the MATCHPROP command. (T/F)

4. You cannot drag and drop the entities from the DESIGNCENTER window. (T/F)

5. A grip is a small square that is displayed on an object at its __________ points.

6. A line has ________  grip points and a polyline has __________.

Figure 6-26  The Drawing Properties dialog box

Self-Evaluation Test
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7. You can enable grips within a block by setting the system variable __________  to 1 (On).

8. The color of the unselected grips can also be changed by using the __________system
variable.

9. You can access the Mirror mode by selecting a grip and then entering __________ or
__________ from the keyboard or giving a null response by pressing the SPACEBAR four
times.

10. The __________ drop-down list will not be available if you select Select All from the Operator
drop-down list in the Quick Select dialog box.

Answer the following questions.

1. If you select a grip of an object, the grip becomes a hot grip. (T/F)

2. To cancel the grip, press the ESC key once. (T/F)

3. The Rotate mode allows you to rotate objects around the base point without changing their
size. (T/F)

4. If you have already added a hyperlink to the object, you can also use the grips to open a file
associated with it. (T/F)

5. Which system variable is used to modify the color of the selected grip?

(a) GRIPCOLOR (b) GRIPHOT
(c) GRIPCOLD (c) GRIPBLOCK

6. Which system variable is used to enable the display of the grips inside the blocks?

(a) GRIPCOLOR (b) GRIPHOT
(c) GRIPCOLD (c) GRIPBLOCK

7. Which system variable is used to modify the size of the grips?

(a) GRIPCOLOR (b) GRIPSIZE
(c) GRIPCOLD (c) GRIPBLOCK

8. By holding down which key you can select and make more than one grips hot?

(a) SHIFT (b) CTRL
(c) ESC (c) ALT

Review Questions
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Figure 6-27  Drawing for Exercise 1

Exercises

Exercise 1 General

9. Which system variable is used to enable the grip mode?

(a) GRIPCOLOR (b) GRIPHOT
(c) GRIPS (c) GRIPBLOCK

10. When you double-click on a circle, the __________ palette is displayed.

11. The GRIPSIZE is defined in pixels, and its value can range from __________  to __________
pixels.

12. When you select a grip for editing, you are automatically in the __________  mode.

13. The __________ mode lets you move the selected objects to a new location.

14. The __________  mode allows you to scale the objects with respect to the base point without
changing their orientation.

15. The Mirror mode allows you to mirror the objects across the __________  without changing
the size of the objects.

1. Use the LINE command to draw the shape, as shown in Figure 6-27(a).
2. Use grips (Stretch mode) to get the shape, as shown in Figure 6-27(b).
3. Use the Rotate and Stretch modes to get the copies, as shown in Figure 6-27(c).



Editing Sketched Objects-II                                                                             6-35

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. F
or

 e
ng

in
ee

ri
ng

 s
er

vi
ce

s,
 c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

Figure 6-28  Drawing for Exercise 2

Exercise 2 Mechanical

Use the draw and editing commands to create the sketch shown in Figure 6-28.

Use the draw and editing commands to create the sketch shown in Figure 6-29.

Exercise 3 Mechanical

Figure 6-29  Drawing for Exercise 3
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Figure 6-30  Drawing for Problem Solving Exercise 1

Use the draw and editing commands to create the drawing shown in Figure 6-30.

Problem Solving Exercise 1 Mechanical
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Problem Solving Exercise 2 Mechanical

Use the draw and editing commands to create the drawing shown in Figure 6-31. Assume the
missing dimensions.

Draw the sketch shown in Figure 6-32 using draw and edit commands. Use the MIRROR
command to mirror the shape 9 units across the Y axis so that the distance between two center
points is 9 units. Mirror the shape across the X axis and then reduce the mirrored shape by 75
percent. Join the two ends to complete the shape of the open end spanner. Save the file. Assume
the missing dimensions. Note that this is not a standard size spanner.

Figure 6-31  Drawing for Problem Solving Exercise 2

Problem Solving Exercise 3 Mechanical
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Figure 6-32  Drawing for Problem Solving Exercise 3

Problem Solving Exercise 4 Architectural

Figure 6-33  Drawing for Problem Solving Exercise 4

Draw the reception desk shown in Figure 6-33. To get the dimensions of the chairs, refer to
Problem Solving Exercise 3 of Chapter 5.

Answers to Self-Evaluation Test
1 - T, 2 - T, 3 - T, 4 - F, 5 - definition, 6 - three, two, 7 - GRIPBLOCK, 8 - GRIPCOLOR,
9 - MIRROR, MI, 10 - Value


